Human Resources (HR) Manager Reports

Generating HR Data Reports at Columbia University

Training Guide
# Table of Contents

**Lesson 1: Columbia University HR Manager Reports**

- The Purpose of this Lesson....................... 1-1
- Lesson Learning Objectives...................... 1-1
- Reporting at Columbia University.............. 1-2
- HR Report Suites................................ ...... 1-3
- How to Generate an HR Manager Report ........ 1-4
- Other myColumbia Portal Links.................. 1-15
- HR Manager Resources Portal Links............ 1-16
- ARC Portal Reporting Links..................... 1-17
- Enterprise Reporting Portal Links............. 1-18
- Manager Self-Service (MSS) Reports.......... 1-19
- The HR Manager Reports........................ 1-20
- Pushed Reports and emails..................... 1-45
- Frequently Asked Questions................... 1-46
- Key Learning Points............................. 1-47
Columbia University HR Manager Reports

The Purpose of this Lesson

The purpose of this lesson is to review the Columbia University Reporting sites, how to access and navigate the application used to generate HR Manager reports and how to view, save and print HR Manager reports.

Lesson Learning Objectives:

At the end of this lesson, you will be able to:

- Recall reporting mechanisms used at Columbia University
- Describe the report components of the HR Data Store
- Access and navigate the HR Manager Resources section of myColumbia
- Access, view, print and save HR Manager Reports
- Describe the available HR Manager Reports
Columbia University streamlines the reporting environments into two repositories: Accounting and Reporting at Columbia (ARC) and the University Data Store (UDS).

ARC provides real-time access to financial data and the University Data Store (UDS) is the data warehouse repository, where data from ARC, PAC/LA, Student, and Historical/Legacy system data is stored.

Within the University Data Store (UDS) is the HR Data Store. The HR Data Store is the location of the HR Manager Reports. The data in the HR Data Store is “day old data”. That is, running a report today displays information as of yesterday.

Each component of the University Data Store (UDS) contains its own suite of reports.

The reports in the HR Data Store are the focus of this course.

The University Data Store (UDS) is the data warehouse repository for Columbia University reports.

The UDS contains the:

- Financial Data Store
- HR Data Store
- Student Data Store
- Integrated Data Store
- Historical Data Store
HR Report Suites

Within the HR Data Store are several suites of PAC and Labor Accounting reports available to help you in managing your day to day activities.

**HR Manager Reports - The HR Manager Reports in the HR Data Store are the focus of this course**

The reports available are:

1. Active Positions and Incumbents Report
2. Active Position Report
3. Employee Personal and Job Data Report by Bargaining Unit
4. Employee Personal and Job Data Report by Job Function
5. Employee Personal and Job Data Report by Position Department
6. Employee Personal Data Report by Bargaining Unit
7. Employee Personal Data Report by Job Function
8. Employee Vacation Accrual
9. Post-Docs Demographics Report
11. Termination Report
12. Upcoming/ Past Appointment End Date Report
13. Upcoming/Past Visa/Permit Expiration Date Report

**Labor Accounting Reports** - Labor Accounting reports provide detail on Fringe Rates, Funding Setup, Cost Transfers, Payroll Information and Suspense Detail.

Access to Labor Accounting Reports is provided to the following PAC roles:
- Manager Self-Service
- Manager Reporter
- Labor Accounting Approver

**Manager Self-Service (MSS) Reports** - Manager Self-Service reports provide individual and department earnings and payroll information.

Access to MSS Reports and HR Manager Reports is provided to the following PAC roles:
- Manager Self-Service
- Manager Reporter

Labor Accounting and MSS reports reside in the HR Data Store and are accessed via a separate path on the myColumbia portal (from the Manager Reports section of PAC). For training information on Labor Accounting and MSS Reports, visit the Course Catalog on the HR Website - http://hr.columbia.edu/course-catalog/search.
Generate an HR Manager Report

Step 1 – Sign on to myColumbia

- Open your web browser (Internet Explorer is preferred)
- Go to www.my.columbia.edu
- Click the Log In Now button
- Enter your UNI and Password
- Click the Log In button

You will be logged into myColumbia, a user interface that brings together access to key information and services into one common place.
Generate an HR Manager Report, cont.

Step 2 – Access the HR Manager Resources Section of myColumbia

- Click the ‘HR Manager Resources’ link at the top of the page

Step 3a – Access the HR Manager Reports

- Click the ‘HR Manager Reports’ link below the ‘Reports’ section on the page. This is the location for the HR Manager Reports
Generate an HR Manager Report, cont.

Step 3b – **HR Reports Only Users** – Landing page is the Home Tab (Launchpad)

The Launchpad is located on the **Home** tab and is a reporting dashboard that displays scheduled and recently run reports. Scheduling is not currently used with HR reports; therefore, this page will not provide you with much detail.

The **Documents** tab is where you can see the list of available reports. If you prefer to have the Documents list be your landing page, please refer to the upcoming Preferences section on how to change your settings.
Generate an HR Manager Report, cont.

Step 3b – Finance and HR Users – Landing page is the Home tab (Launchpad)

If you also have access to Finance reports, the landing page is the Finance Launchpad. The Launchpad provides a quick view of scheduled and recently run Finance reports. It does not display details for other reports, e.g. HR. If you prefer to have the Documents list be your landing page, please refer to the upcoming Preferences section on how to change your settings.

Step 3c – Preference Setting

The Launchpad (home tab) is the landing page once logged in to the site. The general preferences of the Launchpad determine what appears in the default view and your default view is based on your user group(s), (e.g. CAPS, HR, and FINERP Users). However, you have the option to select the Documents tab as your landing page.

To Modify Settings

- Click on Preferences

The Preferences screen appears.

- Click on General
- Clear/uncheck the “Use Default Settings (Administrator defined)” box
- Once “Use Default Settings (Administrator defined)” is unchecked you will be able to proceed and modify

*To restore back to the default view, check/select the “Use Default Settings (Administrator defined)” box.
Generate an HR Manager Report, cont.

Step 3c – Preference Setting, cont.

To display the Documents tab as your default

1. Select “Documents tab”
2. Select “Folders”
3. Select “Public Folder: Browse folder”. The available Report folder list is displayed; this list is based on your access
4. Choose the folder you want as default (HR is chosen in example)
5. Click ‘Open’
6. Click Save & Close
7. Reload your browser for the changes to apply
Generate an HR Manager Report, cont.

Step 4 – Access a report

Click the “Documents” tab and then click the HR folder to view the report list. All of the available reports for HR are displayed. To access a report, double-click the report and the report displays. The reports initially are displayed in HTML format and there are options to save the file in Excel, PDF or Comma delimited if you so choose.

Documents contains the reports

The HR Manager Reports appear. Double click on any of the report lines to access the report

Items may appear on multiple pages. If so, click the arrows to navigate

If the reports do not automatically display upon clicking the Documents tab, click the plus sign next to the ‘Public Folders’ in the Folders section of the left hand menu link to expand the report types (available to you per your access) and then click the folder for the suite of reports you would like to see. Once a report area is selected, e.g. HR, the listing of available reports displays under the Title column.
Generate an HR Manager Report, cont.

Step 5a – Viewing a report without parameters

Once a report is selected, it either displays the information as a chart on the page or it will ask you to enter additional parameters. Below is an example of a report displaying information where no additional parameters need to be entered.

Each report also includes a ‘Report Description’ that provides a brief description of the report along with the parameters selected, if applicable. Click the ‘Report Description’ link on the left hand menu to display the description.

The Report appears in its own tab.

Report example where data displays without additional parameters entered.

Click the Report Description link on the left hand menu to display the report description and user entered parameters, if any.

Click the arrows on the footer of the report to page through reports if there are multiple pages.
Generate an HR Manager Report, cont.

Step 5b – Viewing a report with parameters

Here is an example of generating a report where additional parameters need to be entered. The parameters differ depending upon the report. A complete listing of reports and their parameters follows.

When you ‘double click’ on the report, the report’s parameter entry screen is displayed.

Items with a green check mark indicate that a choice is selected. Some choices default upon report opening but can be changed as needed. In this example all departments you have access to along with all employee job functions and statuses are defaulted to appear. To change any of these, click a report prompt from the left hand side and then click the “Refresh Values” icon and the list to choose from appears. From there you can select an individual item and move it to the selection.

Items with a red arrow indicate that a selection must be made. Once all selections are made, the “OK” button becomes active and the report can be run.
Generate an HR Manager Report, cont.

Step 5c – Saving prompt selections for future report runs

On the top of the parameter entry screen is a field titled, “Available prompt variants”. This feature allows you to save frequently used prompts.

After you enter the selection criteria, click the “create prompt variant button” which is the disc icon with the green plus sign. Then enter a name for the report and click “OK”.

To use the created variant, when you open a new report, on the prompts screen, click the drop down arrow on the available prompts variant box and select the variant you created. The already selected prompts that were saved will be used to generate the report.
Generate an HR Manager Report, cont.

Step 6 – Saving a report

Use the Export Document dropdown list to save the report to your computer. Do not use the “save icon”.

- Click the drop down arrow next to ‘Export Document’ icon
- Select ‘Export Document As’
- Select the file type (e.g. Excel, PDF or CSV)
- Open the exported report
- Name the report and select the location on your computer to save it to using the File > Save command for software it was exported to (e.g. Excel or PDF)

Before viewing, saving or printing a report, ensure that your IE Browser is set up to enable automatic prompting for file downloads. Check this option is selected by bringing up your Internet Explorer and following the links:

Tools-->Internet Options--Security Tab--->Click on Custom Level--->Downloads-->'Enable' the 'Automatic prompting for file downloads'.
Generate an HR Manager Report, cont.

Step 7 – Print a generated report

- Click on the Printer Icon on the menu bar. The output format is PDF.

Note: if you export the report into another format such as Excel, you may also print the report from that format.

Note on the Refresh Data button

- On the toolbar is a ‘Refresh’ icon. As HR Manager Reports contain ‘day old data’, the information is updated nightly and clicking this icon will not return any newer results.
Other myColumbia Portal Links

Before we explore the individual reports, let's review the additional links on myColumbia. Notice when you first logged in, additional links appear at the top of the screen. Access to sites is dependent upon your security authorization and thus which links appear for you. Each link provides access to a specific portal area. Let's explore the links to reporting areas within these other sites.
Other myColumbia Portal Links – HR Manager Resources

Additional reports are located within the Reports Section of the HR Manager Resources page.

- MSS, Labor Accounting Reports, HR Manager Reports, Payroll Reports and DARTS Reports are accessed from this page by clicking on those specific links within the Reports section on the page.

Click here to access reports within the Manager Self-Service application.

Click here to access Labor Accounting reports.

Click here to access the HR Manager Reports.

Note: The HR Manager Reports are also accessible via the Enterprise Reporting link.

Click here to access the Financial Data Store Payroll Reports.

Click here to access Student Information (SIS) reports.
Other myColumbia Portal Links – ARC

Within the ARC Portal is a Reports section that provides real-time and data store access to financial data. There is also a Legacy Reporting section.

The Reporting Quick Links section provides access to real-time and data store financial reports.

The Legacy Reporting section provides access to DARTS and other Legacy Reports.
Other myColumbia Portal Links – Enterprise Reporting

The HR Manager Reports are also located within the Enterprise Reporting Section of myColumbia along with other suites of reports available to you per your access.

To access reports in the Enterprise Reporting section:

- Click on the “My Business Objects InfoView Reports” link from the Enterprise Reporting page
- Click on the ‘Documents’ tab on the top of the page. (The ‘Home’ tab displays the Launchpad)
- Click the plus sign next to the ‘Public Folders’ link to expand the reports types
- Click the folder of the suite of reports you would like to see

Once a report area is selected, e.g. HR, the listing of available reports displays under the Title column. **Note:** if you have access to other report areas, they will appear in the Public Folder list.
Manager Self-Service (MSS) Reports

In addition to the reporting repositories, there is a production site within the PAC Manager Self-Service module where you can generate Manager Self-Service (MSS) Reports and Queries. MSS queries provide detail on Personnel Actions as well as Earnings and Payroll Information in a Department or Employee view.

Once logged in to PAC, navigate to Manager Reports within the Manager Self-Service PAC Menu.

Access to MSS Reports is provided to the following PAC roles:
- Manager Self-Service
- Management Reporter

Access to Labor Accounting Reports is provided to the following PAC roles:
- Manager Self-Service
- Manager Reporter
- Labor Accounting Approver

Refer to the Manager Self-Service Training Guide for information on generating these reports.

**PAC**

- **Production Environment:**
  - Manager Self-Service Reports
  - Labor Accounting Reports

Navigate to Manager Self Service Reports –
Click on “Main Menu > Manager Self Service” > “Manager Reports”.
“Manager Self-Service Reports” and “Labor Accounting Reports” are available here.

**MSS Reports** = Personnel Action, Employee and Department Payroll and Earnings Reports

**Labor Accounting Reports** = Fringe Rates, Funding Setup, Payroll Actuals and Suspense Detail Reports
HR Manager Reports

Now let's review each of the available HR Manager Reports and how to access and view the reports.
Active Positions and Incumbents Report

Report Description

This report displays all active University positions (vacant or filled) and the names of staff filling any of the positions in administrative departments whose data you have access to view.

Report Use

This report is useful to see all of the open positions in a department and who occupies those positions. Position numbers can be obtained which are needed when entering a new hire in the Template-Based Hire application. It also helps if you need to reclassify a position. Note: work with your HR Client Manager when discussing position changes.

Report Parameters

This report does not require data selection to generate.

Report Results

The report results show:

- Position Number
- Position Description
- Salary Admin Plan Code
- Job Code
- Department ID
- Department Name
- Grade
- Max Head Count
- Head Count – if 0 then New or EMP is termed
- Full/Part Time
- Std Hours
- Work Location
- Incumbent Employee ID
- Incumbent Name
- Manager Position Number
- Manager Position Description
- Manager Name
Active Positions Report

Report Description
This report displays all active University positions that are vacant or filled in administrative departments whose data you have access to view.

Report Use
This report is useful to see all of the open positions in a department. In this version, you will not see the names of the employees who occupy (or occupied) the positions. Position numbers can be obtained which are needed when entering a new hire in the Template-Based Hire application. It also helps if you need to reclassify a position. Note: work with your HR Client Manager when discussing position changes.

Report Parameters
This report does not require data selection to generate.

Report Results
The report results show:

- Position Number
- Position Description
- Position Status
- Position Effective Date
- Job Code
- Department ID
- Department Name
- Grade
- Max Head Count
- Head Count
- Full/Part Time
- Std Hours
- Work Location
Employee Personal and Job Data Report– by Bargaining Unit

Report Description
This report displays comprehensive personal and position related data for University employees in the selected administrative department(s) and bargaining unit(s) as recorded in PAC.

Report Use
This report is useful when additional personal or job data not available in Manager Self-Service is needed.

Report Parameters
This report requires data to be selected. Green check marks next to a prompt indicate a defaulted or selected value. Red arrows indicate a selection must be made. Confirm and/or enter prompt values, then click on the “OK” button on the bottom of the screen.

- Admin Department Number (Start)
- Admin Department Number (End)
- Value(s) for Bargaining Unit Name (use % for ALL)
- Employee Status (A; L; P is defaulted)
- Select Term

Admin Department Number (Start & End):
Each user has a listing of the Administrative Department(s) whose information they can view. Although the range displayed is greater, only data within admin departments that you have access to will be displayed.

If you keep the Default settings (0000000) and (9999999) you will get all your departments and associated information.

If you choose to limit the department list you can do so by clicking the Refresh Values options on the right side of the screen then double-clicking on the desired Department value. Or, to enter a specific department, click on “Enter Admin Department Number” (Start) and “Enter Admin Department Number (End)” prompts and after clicking each, enter the seven-digit department number in the “Type values here” box and then click the right facing arrow to select the department.
Employee Personal and Job Data Report– by Bargaining Unit, cont.

Bargaining Unit:
Click on the “Bargaining Unit Name” prompt. The “%” sign defaults as the selection. Use “%” to select all Bargaining Units. If you choose to limit the Bargaining Units you can do so by clicking the Refresh Values options on the right side of the screen. Select the Bargaining Unit in the middle of the screen and then click the right facing arrow to include the selection. Or you can double-click on the desired value and it will be added.

Employee Status:
Three employee statuses (A; L; P) are selected as the default. To limit the list, click on the “Employee Status” prompt. After clicking this line, the employee statuses, A = Active; P = Paid Leave; L = Leave of Absence, display in the middle of the screen and are selected. To remove one of the statuses, click the status letter in the right hand side of box and then click the left facing arrow to remove the selection.

Select Term:
Click on the “Select Term” prompt. After clicking this, select the school term in the middle of the screen and then click the right facing arrow to make the selection. Or you can double-click on the desired value and it will be added.

Select/enter a value for each prompt

Click “OK” to produce the report
Employee Personal and Job Data Report– by Bargaining Unit, cont.

Report Results

The report results show:

- Employee ID
- Admin Department Name, Admin Department Number
- Employee Name, Position Department Name, Position Department Number
- UNI
- Original Hire Date, Service Date
- First Tenure Position Date
- CU Employee Status
- Gender
- DOB
- Ethnic Group, Ethnic Group Description
- Highest Degree, Degree Name, Degree Year, Degree Institution
- Home ZIP
- Extract Date
- Email
- Office Address Line 1, Line 2, Line 3, City, State and Zip Code
- Office Phone Number
- Term Year, Term Code
- Position Number, Position Status, Position Status Description
- Work Location, Work Location Description
- US Citizen, Visa Type Code, Visa Expiration Date
- Tenure Status, Tenure Status Description, Tenure Date
- Active Positions
- Position Entry Date
- Appointment End Date
- Job Code, Job Description, Job Effective Date, Job Function, Job Family, Job Family Description
- Academic Rank, Academic Rank 1, Academic Rank 2
- Grade
- Comp Rate, Comp Rate End Date, Compensation Frequency, Compensation Frequency Description
- Weekly Hours
- Bargaining Unit, Bargaining Unit Description
- Sabbat End Date
- FT/PT Status
- Multiple Positions
- Action Type, Action Reason, Action Reason Description, Action Effective Date
- Position Date Extract Date
- Term ID
- Position Title
- Contract Period Salary
- Leave through Date
Employee Personal and Job Data Report—by Job Function

Report Description

This report displays comprehensive personal and position related data for University employees in the selected administrative department(s) and job function(s) as recorded in PAC.

Report Use

This report is useful when additional personal or job data not available in Manager Self-Service is needed.

Report Parameters

This report requires data to be selected. Green check marks next to a prompt indicate a defaulted or selected value. Red arrows indicate a selection must be made. Confirm and/or enter prompt values, then click on the “OK” button on the bottom of the screen.

- Admin Department Number (Start)
- Admin Department Number (End)
- Job Function (use % for ALL)
- Employee Status (A; L; P is defaulted)
- Select Term

Admin Department Number (Start & End):

Each user has a listing of the Administrative Department(s) whose information they can view. Although the range displayed is greater, only data within admin departments that you have access to will be displayed.

If you keep the Default settings (0000000) and (9999999) you will get all your departments and associated information.

If you choose to limit the department list you can do so by clicking the Refresh Values options on the right side of the screen then double-clicking on the desired Department value. Or, to enter a specific department, click on “Enter Admin Department Number” (Start) and “Enter Admin Department Number (End)” prompts and after clicking each, enter the seven-digit department number in the “Type values here” box and then click the right facing arrow to select the department.
Employee Personal and Job Data Report—by Job Function, cont.

Job Function:

All job functions (%) are selected as the default. To select a specific job function, click on the “Job Function” prompt and then click the Refresh Values options on the right side of the screen then click on the desired Job Function (01, 11, 21, 31, 41, 51, or 61). Then click the right facing arrow to make the selection. Or you can double-click on the desired value and it will be added. Use the “%” to select all job functions.

Job Functions:

- 01 = Officers of Instruction
- 11 = Officers of Research
- 21 = Officers of the Libraries
- 31 = Officers of Administration
- 41 = Student Officers
- 51 = Support Staff
- 61 = Others

Employee Status:

Three employee statuses (A; L; P) are selected as the default. To limit the list, click on the “Employee Status” prompt. After clicking this line, the employee statuses, A = Active; P = Paid Leave; L = Leave of Absence, display in the middle of the screen and are selected. To remove one of the statuses, click the status letter in the right hand side of box and then click the left facing arrow to remove the selection.

Select Term:

Click on the “Select Term” prompt. After clicking this, select the school term in the middle of the screen and then click the right facing arrow to make the selection. Or you can double-click on the desired value and it will be added.

Select/enter a value for each prompt

Click “OK” to produce the report
Employee Personal and Job Data Report– by Job Function, cont.

Report Results

The report results show:

- Employee ID
- Admin Department Name, Admin Department Number
- Employee Name, Position Department Name, Position Department Number
- UNI
- Original Hire Date, Service Date
- First Tenure Position Date
- CU Employee Status
- Gender
- DOB
- Ethnic Group, Ethnic Group Description
- Highest Degree, Degree Name, Degree Year, Degree Institution
- Home ZIP
- Extract Date
- Email
- Office Address Line 1, Line 2, Line 3, City, State and ZIP Code, Office Phone Number
- Term Year, Term Code
- Position Number, Position Status, Position Status Description
- Work Location, Work Location Description
- US Citizen, Visa Type Code, Visa Expiration Date
- Tenure Status, Tenure Status Description, Tenure Date
- Active Positions
- Position Entry Date
- Appointment End Date
- Job Code, Job Description, Job Effective Date, Job Function, Job Family, Job Family Description
- Academic Rank, Academic Rank 1, Academic Rank 2
- Grade
- Comp Rate, Comp Rate End Date, Compensation Frequency, Compensation Frequency Description
- Weekly Hours
- Bargaining Unit, Bargaining Unit Description
- Sabbat End Date
- FT/PT Status
- Multiple Positions
- Action Type, Action Reason, Action Reason Description, Action Effective Date
- Position Date Extract Date
- Term ID
- Position Title
- Contract Period Salary
- Leave through Date
Employee Personal and Job Data Report—by Position Department

Report Description

This report displays comprehensive personal and position related data for University employees in the selected position department(s) and job function(s) as recorded in PAC.

Report Use

This report provides employee data to departments who have faculty appointed in other departments. It allows you to see data for those who have positions in your departments but an admin department that you do not have access to.

Report Parameters

This report requires data to be selected. Green check marks next to a prompt indicate a defaulted or selected value. Red arrows indicate a selection must be made. Confirm and/or enter prompt values, then click on the “OK” button on the bottom of the screen.

- Select Term
- Position Department Number (Start)
- Position Department Number (End)
- Overall Employment Status Code – Employed (A; L; P, S is defaulted)
- Employee Status (A; L; P, S is defaulted)
- Job Function (use % for ALL)

Position Department Number (Start & End):

If you keep the Default settings, you will get all positions in your departments and the associated information.

If you choose to limit the department list you can do so by clicking the Refresh Values options on the right side of the screen then double-clicking on the desired Department value. Or, to enter a specific department, click on “Enter Position Department Number” (Start) and “Enter Position Department Number (End)” prompts and after clicking each, enter the seven-digit department number in the “Type values here” box and then click the right facing arrow to select the department.
Employee Personal and Job Data Report—by Position Department, cont.

Job Function:

All job functions (%) are selected as the default. To select a specific job function, click on the “Job Function” prompt and then click the Refresh Values options on the right side of the screen then click on the desired Job Function (01, 11, 21, 31, 41, 51, or 61). Then click the right facing arrow to make the selection. Or you can double-click on the desired value and it will be added. Use the “%” to select all job functions.

Job Functions:

- 01 = Officers of Instruction
- 11 = Officers of Research
- 21 = Officers of the Libraries
- 31 = Officers of Administration
- 41 = Student Officers
- 51 = Support Staff
- 61 = Others

Overall Employee Status and Employee Status:

Overall Employee Status is the overall University status and applies to those who hold multiple jobs. Employee Status is job specific. The employee statuses of A; L; P & S are selected as the default. To limit the list, click on the respective prompt and the statuses, A = Active; P = Paid Leave; L = Leave of Absence, S = Suspended, display in the middle of the screen and are selected. To remove one of the statuses, click the status letter in the right hand side of box and then click the left facing arrow to remove the selection.

Select Term:

Click on the “Select Term” prompt. After clicking this, select the school term in the middle of the screen and then click the right facing arrow to make the selection. Or you can double-click on the desired value and it will be added.
Employee Personal and Job Data Report—by Position Department, cont.

Report Results

The report results show:

- Employee ID
- Admin Department Name, Admin Department Number
- Employee Name, Position Department Name, Position Department Number
- Original Hire Date, Service Date
- First Tenure Position Date
- Gender
- DOB
- Ethnic Group, Ethnic Group Description
- Highest Degree, Degree Name, Degree Year, Degree Institution
- Home ZIP
- Email
- Office Address Line 1, Line 2, Line 3, City, State and ZIP Code, Office Phone Number
- Term Year
- Position Number, Position Status, Position Status Description
- Work Location, Work Location Description
- US Citizen, Visa Expiration Date
- Tenure Status, Tenure Status Description, Tenure Date
- Active Positions
- Position Entry Date
- Appointment End Date
- Job Code, Job Description, Job Effective Date, Job Family Code, Job Function, Job Family
- Academic Rank, Academic Rank 1, Academic Rank 2
- Grade
- Comp Rate, Comp Rate End Date, Compensation Frequency, Compensation Frequency Description
- Weekly Hours
- Bargaining Unit, Bargaining Unit Description
- Sabbat End Date
- FT/PT Status
- Multiple Positions
- Action Type, Action Reason, Action Reason Description, Action Effective Date
- Position Date Extract Date
- Term ID
- Position Title
- Contract Period Salary
- Leave through Date
Employee Personal Data Report– by Bargaining Unit

Report Description

This report displays comprehensive personal data for University employees in the selected administrative department(s) and bargaining unit(s) as recorded in PAC.

Report Use

This report is useful when additional personal data not available in Manager Self-Service is needed.

Report Parameters

This report requires data to be selected. Green check marks next to a prompt indicate a defaulted or selected value. Red arrows indicate a selection must be made. Confirm and/or enter prompt values, then click on the “OK” button on the bottom of the screen.

- Admin Department Number (Start)
- Admin Department Number (End)
- Employee Status (A; L; P is defaulted)
- Bargaining Unit Name (or use % for ALL)
- Select Term

Admin Department Number (Start & End):

Each user has a listing of the Administrative Department(s) whose information they can view. Although the range displayed is greater, only data within admin departments that you have access to will be displayed.

If you keep the Default settings (0000000) and (9999999) you will get all your departments and associated information.

If you choose to limit the department list you can do so by clicking the Refresh Values options on the right side of the screen then double-clicking on the desired Department value. Or, to enter a specific department, click on “Enter Admin Department Number” (Start) and “Enter Admin Department Number (End)” prompts and after clicking each, enter the seven-digit department number in the “Type values here” box and then click the right facing arrow to select the department.
Employee Personal Data Report– by Bargaining Unit, cont.

**Employee Status:**

Three employee statuses (A; L; P) are selected as the default. To limit the list, click on the “Employee Status” prompt. After clicking this line, the employee statuses, A = Active; P = Paid Leave; L = Leave of Absence, display in the middle of the screen and are selected. To remove one of the statuses, click the status letter in the right hand side of box and then click the left facing arrow to remove the selection.

**Bargaining Unit:**

Click on the “Bargaining Unit Name” prompt. The “%” sign defaults as the selection. Use “%” to select all Bargaining Units. If you choose to limit the Bargaining Units you can do so by clicking the **Refresh Values** options on the right side of the screen. Select the Bargaining Unit in the middle of the screen and then click the right facing arrow to include the selection. Or you can double-click on the desired value and it will be added.

**Select Term:**

Click on the “Select Term” prompt. After clicking this, select the school term in the middle of the screen and then click the right facing arrow to make the selection. Or you can double-click on the desired value and it will be added.

Select/enter a value for each prompt

Click “OK” to produce the report
Employee Personal Data Report– by Bargaining Unit, cont.

Report Results

The report results show:

- Employee ID
- Admin Department Name, Admin Department Number
- Employee Name, Position Department Name, Position Department Number
- Bargaining Unit
- UNI
- Original Hire Date, Seniority Date
- First Tenure Position Date
- CU Employee Status
- Gender
- DOB
- Ethnic Group, Ethnic Group Description
- Highest Degree, Degree Name, Degree Year, Degree Institution
- Home ZIP
- Extract Date
- Email
- Office Address Line 1, Line 2, Line 3, City, State and Zip Code
- Office Phone Number
Employee Personal Data Report – by Job Function

Report Description

This report displays comprehensive personal data for University employees in the selected administrative department(s) and job function(s) as recorded in PAC.

Report Use

This report is useful when additional personal data not available in Manager Self-Service is needed.

Report Parameters

This report requires data to be selected. Green check marks next to a prompt indicate a defaulted or selected value. Red arrows indicate a selection must be made. Confirm and/or enter prompt values, then click on the “OK” button on the bottom of the screen.

- Admin Department Number (Start)
- Admin Department Number (End)
- Job Function (use % for ALL)
- Employee Status (A; L; P is defaulted)
- Select Term

Admin Department Number (Start & End):

Each user has a listing of the Administrative Department(s) whose information they can view. Although the range displayed is greater, only data within admin departments that you have access to will be displayed.

If you keep the Default settings (0000000) and (9999999) you will get all your departments and associated information.

If you choose to limit the department list you can do so by clicking the Refresh Values options on the right side of the screen then double-clicking on the desired Department value. Or, to enter a specific department, click on “Enter Admin Department Number” (Start) and “Enter Admin Department Number (End)” prompts and after clicking each, enter the seven-digit department number in the “Type values here” box and then click the right facing arrow to select the department.
Employee Personal Data Report – by Job Function, cont.

Job Function:

All job functions (%) are selected as the default. To select a specific job function, click on the “Job Function” prompt and then click the Refresh Values options on the right side of the screen then click on the desired Job Function (01, 11, 21, 31, 41, 51, or 61). Then click the right facing arrow to make the selection. Or you can double-click on the desired value and it will be added. Use the “%” to select all job functions.

Job Functions:

- 01 = Officers of Instruction
- 11 = Officers of Research
- 21 = Officers of the Libraries
- 31 = Officers of Administration
- 41 = Student Officers
- 51 = Support Staff
- 61 = Others

Employee Status:

Three employee statuses (A; L; P) are selected as the default. To limit the list, click on the “Employee Status” prompt. After clicking this line, the employee statuses, A = Active; P = Paid Leave; L = Leave of Absence, display in the middle of the screen and are selected. To remove one of the statuses, click the status letter in the right hand side of box and then click the left facing arrow to remove the selection.

Select Term:

Click on the “Select Term” prompt. After clicking this, select the school term in the middle of the screen and then click the right facing arrow to make the selection. Or you can double-click on the desired value and it will be added.
Employee Personal Data Report– by Job Function, cont.

Report Results

The report results show:

- Employee ID
- Admin Department Name, Admin Department Number
- Employee Name
- Position Department, Position Department Name, Position Number
- Position Title, Bargaining Unit
- UNI
- Original Hire Date, Seniority Date
- First Tenure Position Date
- CU Employee Status
- Gender
- DOB
- Ethnic Group, Ethnic Group Description
- Highest Degree, Degree Name, Degree Year, Degree Institution
- Home ZIP
- Extract Date
- Email
- Office Address Line 1, Line 2, Line 3, City, State and ZIP Code
- Office Phone Number
Employee Vacation Accrual Report

Report Description

This report displays the employees to be included in the Year End Vacation Accrual Report exercise. It is a preliminary list that should be reviewed for any changes.

Report Use

This report is useful to gather employee information in preparation for the Year End Vacation Accrual Report exercise. This is a preliminary list of employees and should be reviewed for any changes. This data is refreshed every June in preparation for this exercise.

Report Parameters

This report does not require data selection to generate.

Report Results

The report results show:

- Admin Department
- Job Function Code
- Last Name
- First Name
- Ps Employee ID
Post-Docs Demographic Report

Report Description
This report displays demographic data for all first time post-docs by department and title effective date.

Report Use
This report is useful to obtain post-doc data.

Report Parameters
This report requires data to be selected. Green check marks next to a prompt indicate a defaulted or selected value. Red arrows indicate a selection must be made. Confirm and/or enter prompt values, then click on the "OK" button on the bottom of the screen.

- Department Range (Begin)
- Department Range (End)
- After Title Effective Date

Department Range (Begin & End):
In this report, the department numbers must be entered. Click on the “Department Range” (Begin) and “Department Range (End)” lines on the screen. After clicking each prompt, enter the seven-digit department number in the text box in the middle of the screen.

If you use the Default settings (0000000) and (9999999) you will get all your departments and associated information.

After Title Effective Date:
Click on the “After Title Effective Date” prompt and then click the calendar icon to the right hand side of the text box in the middle of the screen to display the calendar. From there, click on the arrows in the calendar to navigate to the date. Click on the day in the month and year and the date will appear.

Report Results
The report results show:

- Name, UNI, Administrative Department Name, Title, Title Effective Date, Year, Month
Salary Planning Report - available May - July to users with e-Comp Report Access

Report Description
This report displays salary data for University employees in the selected administrative department(s). This report is only viewable by those who have the Enhanced Manager Self-Service security access with E-Comp/Salary Reporting and is only available from May – July.

Report Use
This report is useful when preparing for and administering e-Comp for the annual merit increases.

Report Parameters
This report requires one prompt to be entered. Below is a screen print of the selection screen. Select the department/job function code(s) in the middle of the screen. Then click the right facing arrow to make the selection and then click on the “OK” button.

- Select a Salary Group ID

Salary Group ID:
In this report, the department numbers/job function codes must be selected and moved into the box on the right hand side.

Scroll through the listings on the left hand side and click to select the department/job function code(s). Then click the right facing arrow to make the selection. You can also select *ALL* or you can select one or multiple groups. To select multiple groups, press down the Ctrl key while selecting groups using the left click of the mouse.

Report Results
The report results show:

- Employee ID, Employee Record Number, Name, Administrative Department, Position Department
- Title, Tenure Status, Grade, E-Comp Status
- Visa Expiration Date
- Current Annual Rate, Change Amount, New Annual Rate, Change Percent
- Group ID, Updated, Submitted
Termination Report

Report Description
This report displays details of terminated employees (through e-Term or paper PAF) based upon the department range and position effective date or termination action date.

Report Use
This report is useful when confirming dates and information for terminated employees.

Report Parameters
This report requires data to be selected. Green check marks next to a prompt indicate a defaulted or selected value. Red arrows indicate a selection must be made. Confirm and/or enter prompt values, then click on the "OK" button on the bottom of the screen.

- Department Range (Start)
- Department Range (End)
- From Date
- To Date

Department Range (Start & End):
Each user has a listing of the Administrative Department(s) whose information they can view. Although the range displayed is greater, only data within admin departments that you have access to will be displayed.

If you keep the Default settings (0000000) and (9999999) you will get all your departments and associated information.

If you choose to limit the department list you can do so by clicking the Refresh Values on the right side of the screen then double-clicking on the desired Department value. Or, to enter a specific department, click on “Enter Admin Department Number” (Start) and “Enter Admin Department Number (End)” prompts and after clicking each, enter the seven-digit department number in the “Type values here” box and then click the right facing arrow to select the department.
Termination Report, cont.

From Date and To Date:

Click on the “From Date” and “To Date” lines on the top of the screen. After clicking each line, click the calendar icon to the right hand side of the text box in the middle of the screen to display the calendar. From there, click on the arrows in the calendar to navigate to the date. Click on the day in the month and year and the date will appear.

Report Results

The report results show:

- Employee ID, Employee Record Number
- Name
- Department ID (Number)
- Title
- Job Code
- Grade
- Action Reason
- Effective Termination Date
Upcoming/Past Appointment End Date Report

Report Description
This report displays summary data for all employees whose appointment end date occurs within three months from the date the report is run. This report also lists employees whose appointment end dates have passed.

Report Use
This report is useful for preparing and planning to re-appoint someone and during the annual re-appointment process.

Report Parameters
This report does not require data selection to generate.

Report Results
The report results show:

- Position Department (Number)
- Admin Department (Number)
- Employee ID
- Name
- Position Title
- Appointment End Date
Upcoming/Past Visa/Permit Expiration Date Report

Report Description
This report displays summary data for all employees who have a visa whose expiration date occurs within three months from the date the report is run. This report also lists any employee with an expired visa.

Report Use
This report is useful when determining if an employee’s visa expiration date approached/is approaching.

Report Parameters
This report does not require data selection to generate.

Report Results
The report results show:

- Position Department (Number)
- Admin Department (Number)
- Employee ID
- Name
- Position Title
- Visa End Date
- Visa Type
Pushed Reports and emails

Pushed Report Data by Email

In addition to accessing the MSS, HR Manager and Labor Accounting Reports, there is report data that is system generated and sent to you via email notification.

Pushed Report Data

1. **Casual 560 Hours Report** - this report is sent monthly and includes all casual employees who have worked 420 hours or more. Reference the Casual Hires FAQs (http://hr.columbia.edu/casual-hires-faqs) on the HR Website for more information

2. **Upcoming Visa/Permit Expiration Date** - this report is sent monthly and displays summary data for all employees who have a visa whose expiration date occurs within three months from the date the report is run. This report also lists any employee with an expired visa. Note that this is also a HR Manager Report and can be generated at will

3. **Suspended Employees** - this report is sent weekly and displays employees who have been "hotlined", the emergency process to stop someone's pay. Be sure to submit the PAF to HRPC that indicates the official status of the employee
Frequently Asked Questions

HR Manager Reports

What Reports are Available?

There are 13 Human Resources data reports available that provide information on employee personal, earnings and position data. See the training manual for a description on each of these reports.

How do I access the Reports?

Through myColumbia. myColumbia>HR Manager Resources>Reports>HR Manager Reports. They can also be accessed in the Enterprise Reporting section of myColumbia.

Support

Who do I contact if I have questions?

Submit an inquiry via Service Now - https://columbia.service-now.com/navpage.do. You may also contact your HR Client Manager in Morningside or CUMC Central Human Resources and/or the HR Service Center at 212-851-2888.

What training tools are available to me and how do I access them?

Training for HR Manager Reports is offered as an online learning course. To view training materials and information, visit the Course Catalog on the Human Resources website at http://hr.columbia.edu/course-catalog/search.

How do I correct information appearing in a report?

To correct personal or position data for an employee, please complete a PAF form and submit it through normal channels. For guidance or emergency action please contact your HR Client Manager in Morningside or CUMC Central Human Resources and/or the HR Service Center at 212-851-2888.
Key Learning Points

- The University Data Store (UDS) is the data warehouse repository, where data from ARC, PAC, and Labor Accounting, Student, and Historical/Legacy system data is stored.
- The HR Data Store is the location of the HR Manager Reports.
- The data in the HR Data Store is “day old data”.
- Multiple pages of data can be listed. Click the arrows on the top of the report to view additional pages of data.
- Data can be saved in an Excel format for easy filtering and sorting.
- Access to data is restricted to the approved department access in your security profile.